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Introduction

Thank you for purchasing the Moxa I1A260 RISC-based industrial ready-to-run embedded computer. This
computer features 4 RS-232/422/485 serial ports, dual 10/100 Mbps Ethernet ports, 8 digital input and 8
digital output channels, a VGA output, a CompactFlash socket for adding additional storage space, and USB
ports for a keyboard/mouse connection or for adding additional storage space. These features make the 1A260
series ideal for your industrial embedded applications, such as SCADA, manufacturing automation, and other
industrial applications.

This manual introduces the 1A260’s hardware. After a brief introduction of the hardware features, the manual
focuses on installation and configuration.

The following topics are covered in this chapter:

O Overview
Model Descriptions and Package Checklist
Product Features

Product Hardware Specifications

QQaaa

Hardware Block Diagram



1A260 Hardware Introduction

Overview

The 1A260 embedded computers feature 4 RS-232/422/485 serial ports, dual Ethernet ports, 8 digital input
channels, 8 digital output channels, VGA output, 2 USB hosts and a CompactFlash socket in a compact,
industrial-strength aluminum rugged casing. The DIN-Rail vertical form factor makes the 1A260 a cost effective
solution for installation in small cabinets. This space-saving solution also makes wiring easy, and is the best
front-end embedded controller for industrial applications.

Because of its VGA output capability, the IA260 can be used for protocol conversion or data acquisition for field
site devices, and is also suitable for SCADA systems in industrial applications, such as manufacturing
automation, production line process monitoring, and mining automation. It can serve as an operator interface
terminal at a field site by connecting a VGA monitor and appropriate HMI software.

The 1A260 comes with RS-232/422/485 ports, digital inputs and outputs, and dual LAN ports, making it an ideal
communication platform for redundant network applications.

In addition to the standard model, the 1A260 also comes in a wide temperature model. The IA260-T has an
operating temperature range of -40 to 75°C, making it suitable for harsh industrial automation environments.
The 1A260’s industrial design provides robust and reliable computing, and the RISC-based architecture allows
the 1A260 to operate without generating too much heat. The high communication performance and fan-less
design make the 1A260 ideal for industrial automation environments.

The 1A260 embedded computer uses a Cirrus Logic EP9315 ARM9, 32-bit, 200 MHz RISC CPU. Unlike the X86
CPU, which uses a CISC design, the RISC design architecture and modern semiconductor technology provide
the 1A260 with a powerful computing engine and communication functions, but without generating a lot of heat.
The built-in 32 MB NOR Flash ROM and 128 MB SDRAM give you enough memory to run your application
software directly on the 1A260.

The 1A261/262 runs Linux or WIinCE 6.0 (pre-installed), providing a friendly environment for developing
sophisticated application software. Moxa’s quality software support makes programming and developing
bug-free code easier, quicker, and less expensive.

Model Descriptions and Package Checklist

Two models of the 1A260 are available:

1A260-CE
RISC-based embedded computer with VGA, 4 serial ports, dual LANs, DIO, CompactFlash, USB, WIinCE 6.0

1A260-T-CE
RISC-based embedded computer with VGA, 4 serial ports, dual LANs, DIO, CompactFlash, USB, WinCE 6.0,
wide operating temperature

1A260-LX
RISC-based embedded computer with VGA, 4 serial ports, dual LANs, DIO, CompactFlash, USB, Linux

1A260-T-LX
RISC-based embedded computer with VGA, 4 serial ports, dual LANs, DIO, CompactFlash, USB, Linux, wide
operating temperature
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1A260 Hardware Introduction

Both models are shipped with the following items:

e 1 1A260 Embedded Computer

= Wall-Mounting Kit

= DIN-Rail Mounting Kit (attach to the product’s casing)

= Ethernet Cable: RJ45 to RJ45 cross-over cable, 100 cm

= CBL-4PINDB9F-100: 4-pin header to DB9 female console port cable, 100 cm
= Universal Power Adaptor (includes terminal block to power jack converter)

= Document & Software CD

= Quick installation guide (printed)

= Warranty card

NOTE: Notify your sales representative if any of the above items are missing or damaged.

Product Features

« Cirrus Logic EP9315 ARM9 CPU, 200 MHz

= 128 MB RAM on-board, 32 MB Flash Disk

= VGA interface for field site monitoring

e 4 RS-232/422/485 serial ports

= Dual 10/100 Mbps Ethernet ports for network redundancy
= 8+8 DI/DO channels

= 12 to 48VDC power input design

= Supports CF socket and USB 2.0 Host

= Ready-to-Run WInCE 6.0 or Linux platform

e -40 to 75°C wide temperature model available

Product Hardware Specifications

Computer

CPU: Cirrus EP9315 ARM9 CPU, 200 MHz
USB: USB 2.0 hosts x 2, type A connector
DRAM: DDR2 SDRAM, 128 MB

Flash: NOR Flash, 32 MB

OS (pre-installed): Linux or Windows CE 6.0

Storage

Storage Expansion: CF card type I/11

Display

Graphics Controller: EP9315 internal graphics accelerator engine with TTL graphical signal support
Display Memory: Dynamic video memory (shares system memory)

Display Interface: CRT interface for VGA output, DB15 female connector
Resolution: 1024 x 768, 8 bits

Ethernet Interface

LAN: Auto-sensing 10/100 Mbps ports (RJ45) x 2

Magnetic Isolation Protection: 1.5 kV built-in

Serial Interface

Serial Standards: RS-232/422/485 ports, software-selectable (DB9 male) x 4
ESD Protection: 4 kV for all signals

Console Port: RS-232 (TxD, RxD, GND), 4-pin header output (115200, n, 8, 1)

1-3
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Serial Communication Parameters

Data Bits: 5, 6, 7, 8

Stop Bits: 1, 1.5, 2

Parity: None, Even, Odd, Space, Mark

Flow Control: RTS/CTS, XON/XOFF, ADDC® (automatic data direction control) for RS-485
Baudrate: 50 bps to 921.6 kbps (supports nonstandard baudrates; see user's manual for details)

Serial Signals

RS-232: TxD, RxD, DTR, DSR, RTS, CTS, DCD, GND
RS-422: TxD+, TxD-, RxD+, RxD-, GND
RS-485-4w: TxD+, TxD-, RxD+, RxD-, GND
RS-485-2w: Data+, Data-, GND

Digital Input

Input Channels: DI x 8

Input Voltage: 0 to 30 VDC

Digital Input Levels for Dry Contacts:

« Logic level O: Close to GND

* Logic level 1: Open

Digital Input Levels for Wet Contacts:

* Logic level 0: +3 V max.

* Logic level 1: +10 V to +30 V (COM to DI)
Connector Type: 10-pin screw-fastened terminal block (8 points, COM, GND)
Isolation: 3 kV optical isolation

Digital Output

Output Channels: DO x 8, sink type

Output Current: Max. 200 mA per channel

On-State Voltage: 24 VDC nominal, open collector to 30 V
Connector Type: 9-pin screw-fastened terminal block
Isolation: 3 kV optical isolation

LEDs

System: Power, Ready, Storage

LAN: 10M/Link x 2, 100M/Link x 2 (on connector)
Serial: TxD x 4, RxD x 4

Switches and Buttons
Reset Button: Supports "Reset to Factory Default"

Physical Characteristics

Housing: Aluminum, industrial vertical form factor
Weight: 1 kg (2.22 Ib)

Dimensions: 52 x 112.6 x 162 mm (2.05 x 4.43 x 6.38 in)
Mounting: DIN-rail, wall

Environmental Limits

Operating Temperature:

Standard Models: -10 to 60°C (14 to 140°F)

Wide Temp. Models: -40 to 75°C (-40 to 167°F)

Storage Temperature:

Standard Models: -20 to 80°C (-4 to 176°F)

Wide Temp. Models: -40 to 85°C (-40 to 185°F)

Ambient Relative Humidity: 5 to 95% (non-condensing)

Anti-Vibration: 2 Grms @ IEC-68-2-34, random wave, 5-500 Hz, 1 hr per axis
Anti-Shock: 20 g @ IEC-68-2-27, half sine wave, 11 ms

Power Requirements
Input Voltage: 12 to 48 VDC (3-pin terminal block)
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Input Current:

With no load on USB ports:

« 240 mA @ 24 VDC

= 480 mA @ 12 VDC

With full load on USB ports:

= 450 mA @ 24 VDC

= 900 mA @ 12 VDC

Power Consumption:

With no load on USB ports: 5.8 W
With full load on USB ports: 11 W

Standards and Certifications

Safety: UL 60950-1, CSA C22.2 No. 60950-1-03, EN 60950-1, CCC (GB4943, GB9254, GB17625.1)
EMC: EN 55032 Class A, EN 61000-3-2 Class A, EN 61000-3-3, EN 55024, FCC Part 15 Subpart B Class A
EMS:

IEC 61000-4-2 ESD: Contact: 4 kV; Air: 8 kV

IEC 61000-4-3 RS: 80 MHz to 1 GHz: 3 V/m

IEC 61000-4-4 EFT: Power: 1 kV; Signal: 0.5 kV

IEC 61000-4-5 Surge: Power: 1 kV; Signal: 1 kV

IEC 61000-4-6 CS: Signal: 3 V/m

IEC 61000-4-8 1 A/m

IEC 61000-4-11

Green Product: RoHS, CRoHS, WEEE

Reliability

Automatic Reboot Trigger: Built-in WDT (watchdog timer)

MTBF (mean time between failures)

Time: 145,328 hrs.

Standard: Telcordia (Bellcore) Standard

Warranty

Warranty Period: 5 years

Details: See www.moxa.com/warranty

Note: The Hardware Specifications apply to the embedded computer unit itself, but not to accessories. In
particular, the wide temperature specification does not apply to accessories such as the power adapter and
cables.
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Hardware Block Diagram
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Hardware Introduction

The 1A260 embedded computers are compact and rugged, making them suitable for industrial applications. The
LED indicators allow users to monitor performance and identify trouble spots quickly, and the multiple ports can
be used to connect a variety of devices. The 1A260 comes with a reliable and stable hardware platform that lets
you devote the bulk of your time to application development. In this chapter, we provide basic information
about the embedded computer’s hardware and its various components.

The following topics are covered in this chapter:

O Appearance
» Top View
» Front View
» Rear View

O Dimensions

]

LED Indicators
O Reset Button
» Reset Function
> Reset to Default
O Real Time Clock
O Placement Options
» DIN-Rail Mounting
» Wall Mounting (optional)
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Hardware Introduction

Appearance

Top View

Front View
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Rear View
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LED Indicators

The IA260 has 15 LED indicators on the front panel. Refer to the following table for information about each LED.

LED Name Color Meaning
Green Power is ON.
Power - - - -
Off No power is being received, or power error exists.
Read Green OS is ready and functioning normally (after booting up).
eady -
Off OS is not ready.
Green Data is being written to or read from the storage unit.
Storage —
Off Storage unit is idle.
Orange 10 Mbps Ethernet connection
LAN1, LAN2 -
Green 100 Mbps Ethernet connection
Green Serial port is transmitting TX data to the serial device.
P1-P4 (TX) - - — - -
Off Serial port is not transmitting TX data to the serial device.
Orange Serial port is receiving RX data from the serial device.
P1-P4 (RX) - - — - -
Off Serial port is not receiving RX data from the serial device.

Reset Button

The 1A260 has a reset button located on the top panel. The reset button can be used to do a simple Reset, which
is equivalent to turning the power off and then back on again, or Reset to default, which returns the 1A260 to
its factory default parameter configuration.

Reset Function

Pressing the Reset Button then releasing it in less than one second initiates a hardware reboot. The button
plays the same role as a desktop PC’s reset button.

In normal use, you should NOT use the Reset Button. You should only use this function if the software is not
working properly. To reset an embedded system, always use the operating system’s software reboot command
to protect the integrity of data being transmitted or processed.

Reset to Default

Press and hold the Reset Button continuously for at least 5 seconds to load the factory default configuration.
After the factory default configuration has been loaded, the system will reboot automatically. The Ready LED
will blink on and off for the first 5 seconds, and then maintain a steady glow once the system has rebooted.

We recommend that you only use this function if the software is not working properly and you want to load
factory default settings. The Reset to Default functionality is not designed to hard reboot the 1A260.

ATTENTION

Reset to Default preserves user’s data

The Reset to Default function will NOT format the user directory and erase the user’s data. Using the Reset to
default function will only load the configuration file. The rest of the user’s data stored in the Flash ROM will
remain intact.




1A260 Hardware Hardware Introduction

Real Time Clock

The 1A260’s real time clock is powered by a lithium battery. We strongly recommend that you do not replace
the lithium battery without help from a qualified Moxa support engineer. If you need to change the battery,
contact the Moxa RMA service team.

WARNING

There is a risk of explosion if the battery is replaced by an incorrect type.

Placement Options

DIN-Rail Mounting

The aluminum DIN-Rail attachment plate is already attached to the product’s casing. To attach the plate to
IA260, make sure that the stiff metal spring is facing the top of the 1A260, as shown in the following figures.

STEP1: STEP2:
Insert the top of the DIN-Rail into the slot just The DIN-Rail attachment unit will snap into place as
below the stiff metal spring. shown.

metal
spring

i
:

DIN-Rail

To remove the 1A260 from the DIN-Rail, simply reverse Steps 1 and 2.



1A260 Hardware Hardware Introduction

Wall Mounting (optional)

For some applications, you will find it convenient to mount the 1A260 on the wall, as depicted in the following

illustrations.

STEP 1:
Attach the wallmount kit to
the 1A260’s rear panel with

09ZVI VXOW

O]
2 screws.
Screws » Screws “WoR
Wallmount Kit E :
®
¥
%
1]
STEP 2: 6.0 mm

Mounting the 1A260 on the wall requires 4 screws. Use the switch, with wall mount plates 4>| }47
attached, as a guide to mark the correct locations of the 4 screws. The heads of the
screws should be less than 6.0 mm in diameter, and the shafts should be less than 3.5

mm in diameter, as shown in the figure at the right. 3.5 mm
NOTE Before tightening the screws into the wall, make sure the screw head and shank size are suitable by inserting

the screw into one of the keyhole-shaped apertures of the Wall Mounting Plates.
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Hardware Connection Description

This section describes how to connect the 1A260 to a network and various devices for first time testing

purposes.

The following topics are covered in this chapter:

a

QaoaoaaaoaaQ

]

Wiring Requirements

» Connecting the Power

» Grounding the Unit
Connecting to the Console Port
Connecting to a Display
Connecting to a Keyboard and Mouse
Connecting to the Network
Connecting to a Serial Device
Connecting to the DI/DO

» Digital Input Wiring

» Digital Output Wiring

Insert CompactFlash Card

USB Hosts
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Wiring Requirements

In this section, we describe how to connect various devices to the embedded computer. You should heed the
following common safety precautions before proceeding with the installation of any electronic device:

= Use separate paths to route wiring for power and devices. If power wiring and device wiring paths must
cross, make sure the wires are perpendicular at the intersection point.

NOTE: Do not run signal or communication wiring and power wiring in the same wire conduit. To avoid
interference, wires with different signal characteristics should be routed separately.

* You can use the type of signal transmitted through a wire to determine which wires should be kept separate.
The rule of thumb is that wiring that shares similar electrical characteristics can be bundled together.

= Keep input wiring and output wiring separate.

= When necessary, it is strongly advised that you label wiring to all devices in the system.

ATTENTION

Safety First!
Be sure to disconnect the power cord before doing installations and/or wiring.

Electrical Current Caution!
Calculate the maximum possible current in each power wire and common wire. Observe all electrical codes
dictating the maximum current allowable for each wire size.

If the current goes above the maximum ratings, the wiring could overheat, causing serious damage to your
equipment.

Temperature Caution!
Be careful when handling the unit. When the unit is plugged in, the internal components generate heat, and
consequently the outer casing may feel hot to the touch.

Connecting the Power

The 1A260 has a 3-pin terminal block for a 12 to 48 VDC power input.

The following figures show how the power input interface connects to external power sources. If the power is
properly supplied, the Power LED will light up. The Ready LED will glow a solid green color when the operating
system is ready (it may take 30 to 60 seconds for the operating system to boot up).

Terminal Block

12-48 VDC

O
[o ]| v+
[o ]| v-
BN
O

ATTENTION

The power for this product is intended to be supplied by a Listed Power Supply Unit that is rated to deliver 12
to 48 VDC at a minimum of 1200 mA for 12 VDC, and 260 mA for 48 VDC.
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Hardware Connection Description

Grounding the Unit

Grounding and wire routing helps limit the effects of noise due to electromagnetic interference (EMI). Run the

ground connection from the ground screw to the grounding surface prior to connecting devices.

ATTENTION

This product is intended to be mounted to a well-grounded mounting surface, such as a metal panel.

12-48 VDC SG: The Shielded Ground (sometimes called Protected Ground) contact is the
e} bottom contact of the 3-pin power terminal block connector when viewed
o ]| v+ from the angle shown here. Connect the SG wire to an appropriate grounded
Lo ]| v- metal surface.
SG—xr[e )| &
O
ATTENTION

A shielded-type power core is required in order to meet FCC emission limits and also to prevent interference to

nearby radio and television reception. It is essential that only the supplied power cord be used.

You are cautioned that changes or modifications not expressly approved by the party responsible for

compliance could void your authority to operate the equipment.

Connecting to the Console Port

The 1A260’s console port is a 4-pin pin-header RS-232 port. It is designed for serial console terminals, which

are useful for identifying the boot up message, or for debugging when the system cannot boot up.

- N W b

Serial Console Port & Pinouts Serial Console Cable
Pin Signal
1 TxD
2 RxD
3 NC
4 GND

NC=Not Connected
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Connecting to a Display

The 1A260 comes with a D-Sub 15-pin female connector to connect a VGA CRT monitor. To ensure that the
monitor image remains clear, be sure to tighten the monitor cable after connecting it to the V481. The pin

assignments of the VGA connector are shown below.

DB15 Female Connector Pin No. Signal Definition
5 1 1 Red
2 Green
6000 0 3 Blue
010 ] ooooooo 60 4 —
5 GND
15 11 6 GND
7 GND
8 GND
9 —
10 GND
11 -
12 -
13 H-Sync
14 V-Sync
15 -

Connecting to a Keyboard and Mouse

Use the 2 USB hosts located on the front side of unit to connect a keyboard and mouse to the 1A260.

Connecting to the Network

Connect one end of the Ethernet cable to one of the IA260’s 10/100M Ethernet ports (8-pin RJ45) and the other
end of the cable to the Ethernet network. If the cable is properly connected, the 1A260 will indicate a valid
connection to the Ethernet in the following ways:

1 8 The LED indicator in the upper right corner glows a solid Pin Signal
green color when the cable is properly connected to a 100 1 ETx+
Mbps Ethernet network. The LED will flash on and off when 2 ETx-
Ethernet packets are being transmitted or received. 3 ERx+
4 _
1 g The LED indicator in the upper left corner glows a solid 5 —
orange color when the cable is properly connected to a 10 6 ERX-
Mbps Ethernet network. The LED will flash on and off when 7 —
Ethernet packets are being transmitted or received. 8 _
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Connecting to a Serial Device

Use properly wired serial cables to connect the 1A260 to serial devices. The serial ports of the IA260 use male
DB9 connectors. The ports can be configured by software for RS-232, RS-422, or 2-wire RS-485. The precise
pin assignments are shown in the following table:

Male DB9 Port RS-232/422/485 Pinouts

12345 ) RS-485 RS-485
Pin RS-232 RS-422
(4-wire) (2-wire)
O i] O 1 DCD TXDA(-) TXDA(-) -
2 RxD TXDB(+) TXDB(+) -
3 TxD RxDB(+) RxDB(+) DataB(+)
6789 4 DTR RXDA(-) RXDA(-) DataA(-)
5 GND GND GND GND
6 DSR - — -
7 RTS — — -
8 CTS — — -

Connecting to the DI/DO

The 1A260 has an 8-ch digital input and 8-ch digital output. The digital input channels and digital output
channels are located on the top side of the unit in a terminal block. The pinouts for the 1/0 are shown in the
figure.

Digital Input and Output Channel
(10-pin Terminal Block)

@) O
oo |1 [ 3] onp
o7 | 7 [ 3] poz7
ple | [ 1| poe
o5 | ] [ ]| pos
pi4 | ] [ | po4
o3 |7 [ ]| pos
piz | ] [ | poz2
ot [ ] [ 1] pot
pio | ] [ | poo
on [T [H
@) O

Additional wiring instructions are given below.
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Digital Input Wiring

Dry Contact Wet Contact
éE:ﬂ"_‘EE!L“E éa—ﬂr#ﬂ-ﬂwhg
= O oo oo o O ODoODOooOoooO

NOTE If you are using wet contacts, you must connect “COM” to power.

Digital Output Wiring

ZBEEERAAE

CHEEHARARAO]

i r’é

Insert CompactFlash Card

The 1A260 has a built-in CompactFlash socket that allows users to add additional memory by inserting a
CompactFlash memory card, without any risk to the computer.

Follow the instructions below to insert a CompactFlash card:

1. Remove the power source.

2. Unscrew the CompactFlash socket protection cover which is located on the front of the unit.

3-6
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3. Be sure to insert the CompactFlash card correctly into the protective cover, as shown in the figure below.

P
Pces N

=9od

204 W

4. Insert the CompactFlash protective cover with the CompactFlash card into the socket, as shown in the
figure. Be sure to keep the angle vertical relative to the front panel.

A 3) " 704

5. Screw the protective cover to the font panel.

ATTENTION

The 1A260 does not support CompactFlash hot swap and PnP (Plug and Play) function. It is necessary to remove
power source first before inserting or removing the CompactFlash card.

USB Hosts

The 1A260 provides 2 USB 2.0 full speed hosts (OHCI), type A connectors, which support a keyboard or mouse,
as well as an external flash disk for storing large amounts of data.
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Regulatory Approval Statements

This device complies with part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) This device may not cause harmful interference, and (2) this device
must accept any interference received, including interference that may cause undesired
operation.

Class A: FCC Warning! This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications. Operation of this equipment in
a residential area is likely to cause harmful interference in which case the user will be required to correct the
interference at his own expense.

European Community

Warning:
This is a class A product. In a domestic environment this product may cause radio interference in which case
the user may be required to take adequate measures.
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